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Introduction
Target Audience

This paper is intended for system administrators who are planning to deploy 
VMware Fusion on the Mac OS platform. 

How to Use This Guide

This guide is intended to walk you through the steps necessary to build 
packages of the VMware application and Virtual Machine and then deploy 
these packages at imaging time, via Casper Remote, a policy or the Self Service 
application. Following the steps contained herein you should be able to 
deploy the necessary components to hundreds of machines.

Acknowledgements

JAMF Software would like to thank the VMware Fusion team and is grateful 
for their aid in the production of this document.  The efforts made by VMware 
in supporting virtualization on the Mac are a critical in the adoption of the 
platform.  
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Prerequisites 
The Casper Suite allows you to easily package and deploy VMware Fusion 
along with one or many Virtual Machines to Macs on your network. Deploying 
VMware Fusion uses the original installer package for VMware Fusion and two 
packages created with Composer: One for a Virtual Machine and one for the 
VMware Fusion application settings.

Before you get started, please check the list below and ensure that you have 
the following components:

Requirements:

•	 VMware Fusion 2 with license key
•	 Existing virtual machine or installer media
•	 Composer.app
•	 Casper Admin.app
•	 Access to your JAMF Software Server (JSS)
•	 Casper Remote (optional) 
•	 Casper Imaging (optional)
•	 Self Service (optional)
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Useful Links on Related Topics

VMWare

For additional information from VMware on mass deployment strategies 
outside of the Casper Suite, please refer to their document titled “Mass 
Deployment of VMware Fusion”

www.vmware.com/files/pdf/Mass_Deployment_of_VMware_Fusion_wp2.pdf

Apple Computer

http://www.apple.com/downloads/macosx/system_disk_utilities/

vmwarefusion.html

http://www.apple.com/business/profiles/ocsd/

Wikipedia

http://en.wikipedia.org/wiki/VMware_Fusion

JAMF Software

http://www.jamfsoftware.com/ libraries/pdf_library/
VMware_and_CasperSuite.pdf
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Packaging VMware Fusion

Deploying VMware Fusion uses the installer package from VMware Fusion and 
two packages created with Composer: One for a Virtual Machine, and one for 
the VMware Fusion application settings.

Preparing the VMware Fusion installer for use in  
the Casper Suite:

1. Create a text file that contains your VMware Fusion license key and save it to 
    your desktop as “license.txt” (see fig.1).  

2. Mount the VMware Fusion disk image in the Finder.

3. Navigate to the VMware Fusion disk image and control-click on the “Install  
    VMware Fusion” icon and choose “Show Package Contents”.

4. Copy the package named “Install VMware Fusion.pkg” to your desktop.

5. Control-click on the “Install VMwareFusion.pkg” that you copied to your  
    desktop and choose “Show Package Contents” (see fig. 2).

 
fig. 1

 fig. 2
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6. Navigate to Contents/Plugins/licensingPane.bundle, control-click and  
    choose “Show Package Contents” (see fig. 3).

7. Place the license.txt file from your desktop into Contents/Resources and  
     then close all open windows. You can also copy this file using Terminal.app  
     with the following command (see fig. 4): 

  cp ~/Desktop/license.txt ~/Desktop/Install\ VMware\ 
Fusion.pkg/Contents/Plugins/licensingPane.bundle/Contents/
Resources/

 
fig. 3

 
fig. 4
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8. Install VMware Fusion by launching the “Install VMware Fusion.pkg”.

9. Register VMware Fusion when prompted and configure preferences  
     as  necessary.

10. Quit VMware Fusion.

Create a VMware Fusion Virtual Machine package with 
Composer

1. Launch VMware Fusion from /Applications.

2. Create or add a new virtual machine, ensuring it is saved in  
     /Users/Shared/VM.

3. Configure the virtual machine as desired for deployment. (If you are creating  
     a Virtual Machine for Windows, now is a good time to run sysprep to prepare  
     the Virtual Machine for enterprise deployment.)

4. Quit VMware Fusion and navigate to /Users/Shared/VM.

5. Control-click on the virtual machine file and choose Show Package Contents.

6. Open the file with the suffix “.vmx” (your Virtual Machine settings file) with  
     TextEdit and remove any lines beginning with the following:  

ethernet0.addressType = 
uuid.location = 
uuid.bios = 
ethernet0.generatedAddress = 
ethernet0.generatedAddressOffset = 

7.Locate the text:  

“sharedFolder1.hostPath = “/Users/<username>” 

8. Replace the path “/Users/<username>” with “~” 

9. Save the .vmx file.

10. Launch Composer. (If you are presented with a New Package dialog,  
       click Cancel.) 



11. Drag the Virtual Machine file from /Users/Shared/VM into Composer’s  
       Sources column.

12. When the copy is finished, a package icon will appear in the Sources  
      column. Control-click this icon to rename it to something like  
      “VM-WindowsXP_SP2”.

13. Verify the permissions on the Virtual Machine file within Composer and  
       click Build as DMG.

Create a VMware Fusion Application Settings package  
with Composer:

1. Launch Composer. (If you are presented with a New Package  
     dialog, click Cancel.)

2. Navigate to /Users/<username>/Library/Preferences.

3. Locate the file named “com.vmware.fusion.plist” and the directory  
     named “VMware Fusion”. 

4. Drag both of these files at the same time into the Sources column  
     in Composer (see fig. 6).

5. When the copy is finished, a package icon will appear in the Sources column.  
    Control-click this package to rename it to “VMware Fusion Settings”.

 
fig. 5
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6. Verify the permissions on the settings files within Composer and click Build  
    as DMG (see fig. 7).

When you have finished creating these packages, drag them into Casper 
Admin to make them available for use within Casper. You will then need to set 
the package options to ensure proper installation order and to allow them to 
be later uninstalled.

Configure package options in Casper Admin:

1. Click “New Category” in Casper Admin and create a new category  
     titled “VMware”.

 
fig. 6

 
fig. 7

10



11

2. Drag the three VMware Fusion packages into this new category.

3. Click the VMware category and highlight all of the VMware Fusion packages 
(see fig. 8).

4. With the packages highlighted, select the Index icon at the top of the  
    Casper  Admin window and allow the process to complete.

5. Double-click the “Install VMware Fusion.pkg” in Casper Admin’s package list  
     and set the following options (see fig. 9): 

•	 In the Options tab, set the priority to 10 
•	 Click the checkbox to “Allow this package to be uninstalled by Casper  

or a Policy.” Set the “Install Only if Processor is:” option to “x86”

6. Click OK to save the changes. 

7. Double-click the “VMware Fusion Settings” package in Casper Admin’s  
    package list and set the following options (see fig. 10):

•	 In the Options tab, set the priority to 12. This ensures the settings file is  
installed after the VMware Fusion application. 

•	 Click “Fill User Templates” and “Fill Existing User Home Directories” 
•	 Click “Allow this package to be uninstalled by Casper or a Policy.”  
•	 Set the “Install Only if Processor is:” option to “x86”

 
fig. 8
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8. Click OK to save the changes.

9. Double-click the virtual machine package(s) in Casper Admin’s package list  
     and set the following options (see fig. 11): 

•	 In the Options tab, set the priority to 15. This ensures the virtual machine is 
installed after the required components. 

•	 Click “Allow this package to be uninstalled by Casper or a Policy.”
•	 Set the “Install Only if Processor is:” option to “x86”

 
fig. 9



10. Click OK to save the changes.

11. From the File menu, choose Save and quit Casper Admin.
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fig. 10
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fig. 11

Deploying VMware Fusion

Once you have created the packages above, you can now easily deploy the 
VMware Fusion application, settings, and Virtual Machines to Macs on your 
network.

The Casper Suite offers four primary methods of distributing VMware Fusion to 
your managed Macs, all of which can be enabled at the same time:

•	 Using Casper Remote, when immediate deployments are required.
•	 Automatically via Casper’s Policy Engine, which allows for unattended, 

automatic installation when clients appear on the network.
•	 During the imaging process, eliminating further steps to make a computer 

ready for a user.
•	 User-initiated via the Self Service application, allowing the user to install 

VMware Fusion or additional Virtual Machines when they need it.



Deploying VMware Fusion with 
Casper Remote
The Casper Remote application can be used to immediately deploy VMware 
Fusion and associated Virtual Machine(s) to you managed Macs. This method 
is best for an immediate deployment.  However, it will overwrite any existing 
VMware Fusion installation and also requires the target system to be 
connected to the network.

1. Launch Casper Remote and authenticate to your JAMF Software Server (JSS).

2. In the Computers tab, select the target systems to which VMware Fusion will  
    be deployed.

3. In the packages tab, select the VMware Fusion installer package, the VMware  
    Fusion settings package, and the Virtual Machine you wish to deploy. 

4. Ensure that the VMware Fusion settings package has the options selected to  
     “Fill User Templates (FUT)” and “Full Existing User Home Directories (FEU)”  
    (see fig. 12).
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fig. 12



5. In the Advanced tab check “Update Inventory (Recon)”. 

6. Click “Show plan” in the toolbar of the Casper Remote window and verify  
     that the appropriate computers are selected.
 
7. Click Go to begin the installation.

Deploying VMware Fusion  
with a Policy

Policies allow you to automatically install VMware Fusion along with a Virtual 
Machine onto a specific group of computers based on a certain trigger such 
as startup, login, or a particular timed event such as a known maintenance 
window.

1. Connect to the web interface of your JSS.

2. Click Management and choose Policies.

3. In the Policies window, click “Create New Policy...”

4. In the General tab, enter something like “Install VMware Fusion” as the  
    Display Name and set the Category to “VMware Fusion”.

5. In the “Triggered by” drop down menu, choose the trigger you would like to  
    begin the installation (“startup” is recommended). 

6. In the “Execution Frequency” drop down menu, choose  
     “Once Per Computer”.

7. Choose any days or time range where you do not want the installation  
    process to occur (see fig. 13). 
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8. Click the Scope tab and choose which computers, groups, departments,  
    or buildings will receive VMware Fusion. It is highly recommended that in 
    addition to a department or building you also scope the policy to a specific  
    Smart Computer Group that is set to the minimum hardware requirements  
    and disk space required for VMware Fusion. If necessary, limit the installation  
    to a particular network segment. For example; you could exclude your  
    wireless or VPN network segment to only allow the installation when the  
    client system is physically plugged into the network.

9. In the packages tab, click “Add Package” and choose the Install action for the  
     VMware Fusion installation package, the settings file, and at least one  
     Virtual Machine.

10. Click “Add Package(s)” to add the packages to the policy.

11. Ensure that the VMware Fusion settings package has the options selected  
       to “Fill User Templates (FUT)” and “Full Existing User Home Directories (FEU)”
      (see fig. 14) 

 
fig. 13

 
fig. 14
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12. In the Advanced tab, check “Update Inventory (Recon)” (see fig. 15). 

13. Click the Save Policy button at the bottom of the browser window.

When a client meeting the scope criteria (group membership, network 
segment, department, etc) checks in with the JSS on the specified trigger, it 
will automatically pull down the VMware Fusion packages and log the action 
to the JSS when the installation is complete. 

Deploying VMware Fusion 
During the Imaging Process

VMware Fusion can be deployed when a Mac is imaged with Casper Imaging. 
However, the VMware Fusion installer can only be run when the computer is 
booted off the primary drive. To automate this process you will need to create 
a script to call a policy as soon as the computer reboots. This ensures VMware 
Fusion is installed on the correct drive and still allows the imaging process to 
be automated.

To create a script to trigger a policy at reboot:

1. In TextEdit, create a new file called “FirstBoot.sh” containing the  
    following lines:

#!/bin/bash

#### This is a script to automatically run any policies trigged
#### by the manual run action of “firstboot”, allowing you to
#### install packages that require the Mac to be booted to the
#### primary boot volume.

/usr/sbin/jamf policy -trigger firstboot
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2. Save this file in plaintext and drag it into Casper Admin.

3. Double click on the script inside Casper Admin and click the Options tab.

4. Set the Priority drop down menu to “At Reboot” (see fig. 15).

5. Click OK and save your changes in Casper Admin.

Next, create a policy similar to the one above with the 
following changes:

1. In the General tab, set the Triggered by: drop down menu to “other” and  
    enter “firstboot” in the run action field.

 
fig. 15
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2. In the Execution Frequency drop down menu, choose “Ongoing” to allow the   
    option to install VMware Fusion again if the computer is ever re-imaged.

3. In the Scope tab, you can choose “Assign to All Computers” as the 
    deployment will be specified with a configuration in Casper Admin or at  
    image time with Casper Imaging.

Finally, to deploy VMware Fusion when imaging you  
have two options:

1. Drag the FirstBoot script into the desired configuration in Casper Admin so  
    as to be automatically applied to any Mac imaged with that configuration.

 
fig. 16

 
fig. 17
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OR 

2. When using the Casper Imaging application, click the Scripts tab and select  
    the FirstBoot script. Ensure it is set to run At Reboot (see fig 18).   

Deploying VMware Fusion with 
the Self Service Application
By configuring a policy to be triggered by Self Service, your users can install 
VMware Fusion and Virtual Machines on demand without assistance from IT. 
This offers the flexibility of also allowing the users to choose exactly when the 
installation will occur, as well as allowing them to reinstall a corrupt Virtual 
Machine or upgrade to a new one.

Create a Self Service policy for the VMware Fusion application:

1. Connect to the web interface of your JSS.

 
fig. 18
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2. Click the Management tab and choose Policies.

3. Click “Create New Policy...” 

4. In the General tab, enter something like “Install VMware Fusion” as the 
    Display Name and set the Category to “VMware Fusion”.

5. In the “Triggered by” drop down menu, choose “None (or Self Service Only)”.

6. In the “Execution Frequency” drop down menu, choose  
     “Once Per Computer”.

7. Choose any days or time range when you do not want the installation  
     process to occur (see fig. 19).

8. Click “Scope” and choose which computers, groups, departments, or  
     buildings will receive VMware Fusion. You will still want to make special note 
     of the scoping options to ensure only appropriate computers are able to  
     install the software.

9. Click “Self Service” and choose Allow this Policy to be used for Self Service.

10. Enter a brief description of the VMware Fusion application along with the  
       current version you are deploying.

11. Click “Choose File...” and locate an icon to represent VMware Fusion. This  
       icon can be a PNG, JPEG, or ICNS file. (You can find the actual icon file in / 
       Applications/VMware Fusion.app/Contents/Resources/fusion.icns) Upload  
       the selected file and you will be returned to the Self Service tab.

 fig. 19
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12. If you would like this policy to appear on the first page presented to the  
       user when they launch the Self Service application, click the box next to  
       “Feature this Policy on the Main Page”. Otherwise choose “Display” and/or  
       “Featured” for the policy to appear in the VMware Fusion category inside 
       the Self Service application (see fig. 20). 

13. In the Packages tab, click “Add Package” and choose the Install action for  
       the VMware Fusion installation package and settings file.

14. Click “Add Package(s)” to add the packages to the policy.

15. Ensure that the VMware Fusion settings package has the options selected  
       to “Fill User Templates (FUT)” and “Full Existing User Home Directories (FEU)”
       (see fig. 21)

16. In the Advanced tab, check the box next to “Update Inventory (Recon)”  
       (see fig. 22). 

 

 

fig. 20

fig. 21
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17. Click “Save Policy” at the bottom of the browser window.

Create a Self Service policy for a VMware Fusion  
Virtual Machine:

1. Connect to the web interface of your JSS.

2. Click “Management” and choose “Policies”.

3. Click “Create New Policy...”

4. Click “General” and enter something like “VM-Windows XP” as the Display  
     Name and set the Category to “VMware”.
 
5. In the “Triggered by” drop down menu, choose “None (or Self Service Only)”.

6. In the “Execution Frequency” drop down menu, choose “Ongoing” to allow  
    users to reinstall the Virtual Machine if necessary.

7. Choose any days or time range when you do not want the installation  
     process to occur (see fig. 23). 

 
fig. 22

fig. 23
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8. Click “Scope” tab and choose which computers, groups, departments, or  
     buildings will receive the Virtual Machine. You will still want to make special 
     note of the scoping options to ensure only appropriate computers are able  
     to install the software. If you are deploying a Virtual Machine that requires  
     a specific version of VMware Fusion, be sure to consider that selection  
     criteria in the Smart Computer Group along with available disk space. If you  
     are introducing a new virtual machine to your environment, you can simply  
     create a Smart Computer Group containing only those computers that have  
     VMware Fusion already installed.

9. Click Self Service and choose Allow this Policy to be used for Self Service.

10. Enter a brief description of the Virtual Machine you are deploying.

11. Click “Choose File...” and locate an icon to represent the virtual machine. 
This can be in the format of a PNG, JPEG, or ICNS file. Upload the selected file 
and you will be returned to the Self Service tab.

12. If you would like this policy to appear on the first page presented to the 
user when they launch the Self Service application, click the box next to 
“Feature this Policy on the Main Page”. Otherwise choose “Display” and/or 
“Featured” for the policy to appear in the VMware Fusion category inside the 
Self Service application (see fig. 25).  

 
fig. 24
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13. In the Packages tab, click “Add Package” and choose the Install action for  
       the Virtual Machine.

14. Click “Add Package(s)” to add the packages to the policy (see fig. 26)

15. In the Advanced tab, check “Update Inventory (Recon)”. 

16. To ensure this Virtual Machine is listed in the Virtual Machine Library once 
installed, enter the following command in the “Run Unix Command” field of 
the advanced tab (this assumes that the Virtual Machine is located at “/Users/
Shared/VM/Windows XP Professional”) (see fig. 27):  

defaults write com.vmware.fusion VMFavoritesListDefaults2 
-array-add ‘{name = “Windows XP Professional”; path = “/
Users/Shared/VM/Windows XP Professional.vmwarevm”;}

 
fig. 25

fig. 26
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17. Click Save Policy at the bottom of the browser window.

When users launch the Self Service application, they will be presented with the 
VMware Fusion and Virtual Machine policies and can install them without local 
administrator rights to their computer (see fig. 28).

 

 

fig. 27

fig. 28
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